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Методичні вказівки призначені для виконання контрольної роботи з 

курсу “Комп’ютерні мережі”  для студентів, що навчаються  за напрямом 

підготовки 6.050903 “Телекомунікації” (ТКС)  заочної форми навчання. 

Методичні вказівки містять відомості з теорії, порядок виконання 

контрольної роботи,  рекомендовану літературу. 
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МЕТОДИЧНІ ВКАЗІВКИ ПО ВИВЧЕННЮ КУРСУ 

"КОМП’ЮТЕРНІ  МЕРЕЖІ" 

 

Метою вивчення курсу "Комп’ютерні мережі"  є надання студентам знань 

і практичних навичок в питаннях аналізу та аналітичного проектування систем 

та мереж комп’ютерного зв’язку. 

 

Вивчення курсу "Комп’ютерні мережі" складається з: 

1) самостійної роботи над навчальними посібниками; 

2) самостійного виконання контрольних завдань; 

3) слухання лекцій і виконання лабораторних робіт на настановних сесіях. 

 

Тематичний план дисципліни. 

1. Вступ 

Основні поняття і визначення. Еволюція комп’ютерних систем та мереж. 

2. Загальні принципи побудови комп’ютерних мереж 

Основні проблеми побудування комп’ютерних мереж. Приклади 

стандартного розв’язання мережевих проблем. Топологія мереж. 

Адресація в комп’ютерних мережах. 

3. Мережева модель “Відкриті системи” 

Поняття про “Відкриту систему”, проблеми стандартизації. Базові 

поняття багаторівневого підходу: протокол, інтерфейс, стек. Рівні моделі 

OSI. Модульність, стандартизація. Стандартні стеки комунікаційних 

протоколів.  

4. Базові технології локальних мереж 

Протоколи і стандарти локальних мереж. Протокол LLC-рівня. Базова 

технологія Ethernet: метод доступу, формат кадрів, фізичне середовище, 

методи розрахунку. Інші базові технології: Token Ring, FDDI, Fast 

Ethernet, 100VG-AnyLan, Gigabit Ethernet, 10GB Ethernet, Wi-Fi. 

5. Побудова комп’ютерних мереж за стандартами фізичного та канального 

рівня 
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Структурована кабельна система. Різновиди мережевого обладнання 

фізичного та канального рівня: адаптери, концентратори. Фізична 

структуризація мереж на базі концентраторів. Канальне мережеве 

обладнання – мости, комутатори. Логічна структуризація за допомогою 

комутаторів. Технічна реалізація комутаторів. Додаткові можливості. 

Типові схеми використання комутаторів. 

6. Побудова комп’ютерних мереж  за стандартами мережевого рівня 

Загальне поняття про взаємодію між мережами. Принципи 

маршрутизації. Протоколи та функції маршрутизаторів. Адресація в IP-

мережах. IP-проткол. 
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ТЕОРЕТИЧНА  ЧАСТИНА  

 

Загальні поняття комп’ютерних мереж 

1. Які вимоги до системи адресації у комп’ютерних мережах? Які види 

адресації використовуються? 

2. У чому полягає проблема спільного використання ліній зв’язку?  

3. Охарактеризуйте топології локальних мереж. 

4. Охарактеризуйте методи доступу к спільному розділеному середовищу 

передачі. 

5. Які функції виконує 1 рівень моделі OSI? Навести приклади пристроїв та 

обладнання 1 рівня. 

6. Які функції виконує 2 рівень моделі OSI? Навести приклади пристроїв та 

обладнання 2 рівня. 

7. Які функції виконує 3 рівень моделі OSI? Навести приклади пристроїв та 

обладнання 3 рівня. 

8. Які функції виконує 4 рівень моделі OSI? Навести приклади пристроїв та 

обладнання 4 рівня. 

9. Як перетворюється інформація при переході з одного рівня моделі OSI на 

інший? У яких випадках загальний обсяг інформації збільшується, а в 

яких – зменшується? Навести приклад з реального протоколу. 

10. Протокол, інтерфейс, стек протоколів. Навести приклади стеків. 

 

 

Базові протоколи комп’ютерних мереж 

11. Для чого у системі стандартів IEEE 802 другий рівень моделі OSI 

розділено на 2 підрівні? Назвіть та охарактеризуйте ці рівні. 

12. Які функції виконує підрівень LLC? Які є різновиди процедур LLC? 

13. Формати кадрів LLC. Призначення кожного поля кадру LLC.  
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14. Які функції виконує підрівень МАС? Основні різновиди базових 

технологій за ознакою МАС та їхня стисла характеристика. 

15. Алгоритм доступу CSMA/CD. Навести осцилограми та розкрити зміст 

алгоритму. Переваги та недоліки. 

16. Охарактеризувати технологію 10Base-5, навести числові показники 

роботи, переваги та недоліки. Навести приклад побудування мережі. 

17. Охарактеризувати технологію 10Base-2, навести числові показники 

роботи, переваги та недоліки. Навести приклад побудування мережі. 

18. Що означає правило „5-4-3”? Чим воно обумовлене? Підтвердити 

розрахунком за стандартною методикою. 

19. Охарактеризувати технологію 10Base-Т, навести числові показники 

роботи. Навести приклад побудування мережі. 

20. Що означає режим „full duplex”? Які різновиди Ethernet підтримують 

його, а які – ні? Роз’яснити, чому. 

21. Що означає „link test pulse” або „link beat”? У яких різновидах Ethernet 

воно використовується і для чого? Пояснити з урахуванням методів 

кодування.  

22. Що означає правило „4 концентратори”? Чим воно обумовлене? 

Підтвердити розрахунком за стандартною методикою. 

23. За якою топологією побудовано мережу 10Base-T? Відповідь 

обґрунтувати. 

24. Яке обмеження на довжину кадру: максимальне та мінімальне? Чим воно 

обумовлене? 

25. Чотири формати кадрів Ethernet. Пояснити призначення кожного поля. 

26. Як побудовано адресу Ethernet? Які бувають види адресів і чим вони 

відрізняються? 

27. Як з’єднуються у технології 10Base-T між собою жили конекторів RJ-45 

на боці комп’ютера та на боці концентратора? В який спосіб можна 

зв’язати між собою 2 концентратори або концентратор та комутатор? 

28. Охарактеризуйте технологію 100Base-TХ?  

29. Охарактеризуйте технологію 100Base-FX?  
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30. Охарактеризуйте технологію 100Base-Т4?  

31. Чим відрізняються концентратори 100Base першого та другого класу? 

Чому  у концентраторів першого класу затримка сигналу більша за 

концентратори другого класу? 

32. Розповісти про autonegotiation у технології 100Base. До якого рівня 

моделі OSI воно відноситься? 

33. Технологія Gigabit Ethernet. Які проблеми виникають у ній і як вони 

розв’язуються? 

34. Технологія Gigabit Ethernet. Які види ліній зв’язку та методи кодування 

використовуються? Навести числові характеристики. 

35. Охарактеризуйте технологію Token Ring. 

36. Охарактеризуйте технологію FDDI.  

37. Охарактеризуйте технологію 100 VG – AnyLAN. 

 

 

Побудування мереж за протоколами 2 рівня. 

38. Які проблеми існують у мережах, побудованих на середовищі загального 

доступу? Навести приклад для „загальної шини”. 

39. Які проблеми існують у мережах, побудованих на середовищі загального 

доступу? Навести приклад для „маркерного кільця”. 

40. Як структуризація мережі розв’язує проблеми доступу до середовища? 

Навести приклад структуризації. Розкрити поняття „домен колізій”. 

41. Алгоритм роботи комутатора. Етапи цього алгоритму. Як 

розповсюджуються кадри по портах? 

42. Проблема замкнених контурів при роботі комутаторів.  

43. Чи існує проблема замкнених контурів при роботі концентраторів? 

Навести приклад розповсюдження кадру у мережі з замкненим контуром 

на концентраторах. 

44. Проблема „широкомовного шторму” при роботі комутатора. Чим вона 

обумовлена і як вона розв’язується. 
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45. Алгоритми роботи мережного адаптера з портом комутатора. Чим 

обмежений домен колізій при роботі з комутатором? У яких режимах є 

колізії, а у яких – немає? 

46. Звідки виникає проблема управління потоком при роботі комутаторів? 

Чому такої проблеми не існує при роботі через середовище загального 

доступу? 

47. Проблема управління потоком при повнодуплексному режимі. Як вона 

розв’язується? 

48. Проблема управління потоком при напівдуплексному режимі. Як вона 

розв’язується? 

49. Як розв’язується проблема замкнених контурів при роботі комутаторів? 

Розкрити алгоритм Spanning Tree і навести приклад його роботи. 

50. Що таке „віртуальні локальні мережі”? Для чого вони використовуються? 

51. Що таке „транкове сполучення”? Чи завжди сполучення між 

комутаторами є транковим? Які є стандарти на транкові сполучення? 

52. Транкове сполучення за стандартом 802.1Q. Формат кадру, переваги та 

недоліки. 

53. Транкове сполучення за стандартом ISL. Формат кадру, переваги та 

недоліки. 
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ПРАКТИЧНА  ЧАСТИНА 
ЗАВДАННЯ 1. МЕТОДИКА РОЗРАХУНКУ МЕРЕЖІ ETHERNET 

 

Основний зміст розрахунку полягає в обчисленні затримки 

розповсюдження сигналу через комунікаційну мережу для одного сегмента. Як 

відомо з теорії, ця затримка не повинна перебільшувати деякої цифри – бо 

інакше факт виникнення колізії не буде розпізнано вузлом, який передає 

інформацію, і той не зробить повторної передачі. Контрольною цифрою для 

оцінки затримки є тривалість кадру найменшої довжини, тому що колізії на 

довгих кадрах розпізнаватимуться напевно. 

Існує емпіричне правило „5-4-3” для коаксіального середовища та 

правило „4 хаби” для крученої пари. Ці правила вимагають, щоб довжина 

кабелю в одній ділянці не перебільшувала стандартне значення, та будь-який 

шлях проходив не більше, як через 4 повторювачи – тоді затримка не буде 

перебільшувати контрольної цифри. Але в реальних мережах часто виникає 

потреба або трішки порушити загальну довжину (наприклад, розтягнути 

мережу на велику площу), або скласти структуру мережі з різнорідних ділянок. 

У такому випадку потрібно більш точний розрахунок – мережа, яка порушує 

емпіричне правило, теж може бути цілком працездатною, та до того ж ще й 

економічною. 

Для гарантії працездатності 10-мегабітної мережі стандарт 802.3 вимагає 

виконання таких умов: 

- кількість станцій у мережі – не більше 1024; 

- довжина кабелю на кожній ділянці – не більше нормативної цифри для 

даного виду кабелю; 

- показник затримки PDV (подвійний час обігу сигналу) не більший за 

575 бітових інтервалів (це тривалість кадру найменшого розміру); 

- показник PVV (зменшення міжкадрового інтервалу) не більше за 49 

бітових інтервалів. 
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Нагадаю, що одиниця виміру часу у розрахунках – не секунда, а бітовий 

інтервал, тривалість якого для 10-мегабітної технології дорівнює 0.1 мкс. За 

умов виконання цих вимог мережа буде працездатною й тоді, коли у ній буде 

не більше як 4 повторювачи на шляху. 

Затримка кожного сегменту складається з „базової” затримки (це є 

сумарна затримка у портах комп’ютера або концентратора з обох боків лінії 

зв’язку), та затримки розповсюдження: 

T = ∑ (Tбазова + tлінії*Lлінії) 

Для розрахунку за стандартом пропонується таблиця 1.1, де наведено всі 

потрібні затримки у бітових інтервалах. Базова затримка залежить від 

технології та від того, чи підключений сегмент до передавача („лівий”), чи до 

приймача („правий”), чи є транзитним („проміжний”). Затримка лінії залежить 

від типу кабелю та від його довжини. Цифри, наведені у таблиці, вміщують в 

собі подвійний показник часу, тому результат не треба множити на 2. 

Для розрахунків треба спочатку накреслити найдовший шлях 

розповсюдження сигналу. Для кожної ділянки вказати технологію та довжину 

кабелю, а також вказати, яким сегментом вона є – „лівим”, „проміжним”, 

„правим”. Умовно вважається, що один з комп’ютерів тільки передає 

інформацію, а другий – тільки приймає. Той, що передає, вважається за 

підключений до „лівого сегменту”, і для нього цифри затримки вибираються з 

першого стовпчика. Той, що приймає, вважається за підключений до „правого 

сегменту”, і для нього цифри вибираються з третього стовпчика. Решта 

сегментів розраховуються за цифрами другого стовпчика. 

Hub Hub Repeater Repeater

Приймач

лівий
сегмент

10Base-T
100м

проміжний
сегмент-1
10Base-FL

1000m

проміжний
сегмент-2
10Base-FB

500m

проміжний
сегмент-3
10Base-FB

500m

проміжний
сегмент-4
10Base-5

400m

правий
сегмент

10Base-2
150m

Repeater

Передавач    

Рисунок 1.1 Схема найдовшого шляху. 
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     Таблиця 1.1 

Тип 

сегменту 

База 

лівого 

сегменту 

База 

проміжного 

сегменту 

База 

правого 

сегменту 

Затримка 

середовища 

на 1 м 

Максимальная 

довжина 

сегменту 

 1 2 3 4 5 

10Base-5 11.8 46.5 169.5 0.0866 500 

10Base-2 11.8 46.5 169.5 0.1026 185 

10Base-

T 

15.3 42.0 165.0 0.113 100 

10Base-

FB 

- 24.0 - 0.1 2000 

10Base-

FL 

12.3 33.5 156.5 0.1 2000 

FOIRL 7.8 29.0 152.0 0.1 1000 

AUI (> 

2м) 

0 0 0 0.1026 2+48 

 

Ось приклад розрахунку для сегментів на рисунку 1.1: 

Лівий сегмент: 15.3 + 100*0.113 = 26.6 

Проміжний сегмент-1: 33.5 + 1000*0.1 = 133.5 

Проміжний сегмент-2: 24 + 500*0.1 = 74.0 

Проміжний сегмент-3: 24 + 500*0.1 = 74.0 

Проміжний сегмент-4: 46.5 + 400*0.0866 = 81.14 

Правий сегмент: 169.5 + 150*0.1026 = 184.89 

Загалом: 574.13 (< 575 bt) 

З розрахунків видно, що результат задовольняє контрольній цифрі, отже, 

мережа є працездатною у першому наближенні, хоча вона не відповідає 

правилу „3-4-5”. Тепер треба поміняти правий та лівий сегменти місцями і 
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розрахувати знов – цифра буде трохи відрізнятися, тому що для крученої пари 

та коаксіального кабелю затримки на лівому та на правому боці суттєво 

відрізняються.  

Лівий сегмент: 11.8 + 150*0.1026 = 27.19 

Проміжний сегмент-1: 46.5 + 400*0.0866 = 81.14 

Проміжний сегмент-2: 24 + 500*0.1 = 74.0 

Проміжний сегмент-3: 24 + 500*0.1 = 74.0 

Проміжний сегмент-4: 33.5 + 1000*0.1 = 133.5 

Правий сегмент: 165.0 + 100*0.113 = 176.3 

Загалом: 566.13 (< 575 bt) 

Такий результат теж задовольняє контрольній цифрі. Але на цьому 

розрахунок не закінчується – ще треба обчислити показник PVV, який 

відображає зменшення міжкадрового інтервалу при проходженні сигналу через 

повторювачи. Для цього є така таблиця: 

 

  Таблиця 1.2 

Тип сегмента Передаючий 

сегмент 

Проміжнй 

сегмент 

10Base-5 или 10Base-2 16 11 

10Base-FB  - 2 

10Base-FL 10.5 8 

10Base-T 10.5 8 

 

Зверніть увагу, що, на відміну від розрахунку PDV, цифри для 

передаючого („лівого”) та проміжного сегментів наводяться, а для 

приймаючого – ні. Це пояснюється тим, що зменшення між кадрового 
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інтервалу визначається не для ділянки лінії зв’язку, а для повторювача, отже, 

останній повторював на шляху є проміжним, бо приймачем є сам комп’ютер. 

Показник PVV є просто сумою цифр для всіх ділянок: 

Передаючий сегмент: 10.5 

Проміжний сегмент-1: 8 

Проміжний сегмент-2: 2 

Проміжний сегмент-3: 2 

Проміжний сегмент-4: 11 

Загалом: 33.5 (< 49) 

Аналогічно розрахунок у зворотному напрямку: 

Передаючий сегмент: 16 

Проміжний сегмент-1: 16 

Проміжний сегмент-2: 2 

Проміжний сегмент-3: 2 

Проміжний сегмент-4: 8 

Загалом: 44 (< 49) 

В обох напрямках показник PVV задовольняє контрольній цифрі, отже, 

кінцевий висновок: мережа є працездатною по всіх показниках.  

Для гарантії працездатності мережі 100Base методика розрахунку дещо 

відрізняється. Як і для 10Base-T, задано максимальну довжину ліній зв’язку – 

100 м для 100Base-Tx (T4), 412 м для 100Base-Fx (half duplex), 2000 м для 

100Base-Fx (full duplex). Загальна затримка на шляху розраховується, як сума 

трьох складових : 

T = ∑ (Tпорт + Tконцентратор + tлінії*Lлінії) 

Для портів (вірніше, для пар портів, що взаємодіють через концентратор) 

рахується затримка за таблицею 1.3 
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 Таблиця 1.3 

Вид передачі  

між портами 

Затримка 

Tпорт 

TX-TX 

TX-FX 

FX-FX 

100 bt 

T4-T4 138 bt 

TX-T4 

FX-T4 
127 bt 

Окремо враховується затримка, яку додає сам концентратор (на 

внутрішню обробку), за таблицею 1.4. Вона залежить від типу перекодування – 

концентратори 1 класу, які підтримують перекодування на логічному рівні (між 

100Base-T4 та 100Base-TХ або 100Base-FX), вносять затримку більше, ніж 

концентратори 2 класу (таблиця 1.4)  

  Таблиця 1.4 

Клас концентратора Види портів Затримка 

Tконцентратор 

1 TX, FX, T4 70 bt 

TX, FX 46 bt 
2 

T4 33.5 bt 

Задається також затримка лінії на 1 метр для кожного виду середовища – 

у таблиці 1.5: 

 Таблиця 1.5 

Тип кабелю Затримка 

tлінії 

UTP-3 1.14 bt 

UTP-5 1.12 bt 

STP 1.12 bt 

Fiber Optic 1.0 bt 
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Затримки вказано вже подвійними, тому, загальна затримка рахується, як 

сума затримки портів, концентратора та лінії по всіх ланках на шляху між 

самими дальніми вузлами мережі. Контрольна цифра: T<512 bt, на відміну від 

10Base, тому що затримки, вказані у таблицях, враховують і преамбули. 

Рекомендується розраховувати з запасом 4 bt (тобто, T<508), хоч і гарантується 

робота без запасу. Показник PVV для технології 100Base не розраховується, 

тому що в ній немає витрат часу на синхронізацію – між передавачем та 

приймачем завжди є безперервний потік даних. 

Розглянемо, наприклад, такий шлях (рис.1.2.): 
 

Computer Hub Hub Computer

100Base-Tx
75m

100Base-Fx
120m

100Base-T4
50m

 
Рисунок 1.2. Схема шляху для технології 100Base-T 

 

Розрахуємо затримки для всього шляху передачі сигналу: 

Перший концентратор: Tпорт = 100, Tконцентратор = 46. 

Другий концентратор: Tпорт = 127, Tконцентратор = 70. 

Перша ділянка лінії зв’язку: tлінії*Lлінії = 1.12 * 75 = 84 

Друга ділянка лінії зв’язку: tлінії*Lлінії = 1.0 * 120 = 120 

Третя ділянка лінії зв’язку: tлінії*Lлінії = 1.14 * 50 = 57 

Загальна затримка: T = 377 bt (< 512 bt), задовольняє контрольній цифрі. 

Отже, мережа є працездатною.  

ЗМІСТ ЗВІТУ 

1. Обґрунтування поділу мережі на домени колізій 

2. Схему найдовшого шляху (відповідає номеру варіанта). 

3. Хід розрахунку. 

4. Висновки по роботі з аналізом результатів. 
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4.Сервер
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10Base-T 90m
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Сервер БД
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4 вариант: 1 - 8
5 вариант: 1 -  9

6 вариант:  1 - 10

7 вариант: 2 -  6
8 вариант: 2 - 7
9  вариант: 2 - 8
10 вариант: 2 - 9
11 вариант: 2 - 10
12  вариант: 2 - 11

13 вариант: 3 - 7
14 вариант: 3 - 8
15 вариант: 3 - 9
16 вариант: 3 - 10
17 вариант: 3 - 11
18 вариант: 3 - 12

19 вариант: 4 - 8
20 вариант: 4 - 9
21 вариант: 4 - 10
22 вариант: 4 - 11
23 вариант: 4 - 12
24 вариант: 4 - 1

Рис.4.1. Мережа для розрахунку 10Base

 



 

 - - 17 - - 

10
0B

as
e-

T4
 9

0m

10
0B

as
e-

T4
 8

0m

10
0B

as
e-

T4
 7

5m

10
0B

as
e-

T4
 7

0m

10
0B

as
e-

Tx
 8

0m

10
0B

as
e-

Tx
 7

0m

10
0B

as
e-

Tx
 9

0m

10
0B

as
e-

Fx
 3

80
m

10
0B

as
e-

Tx
 1

00
m

10
0B

as
e-

Tx
 7

0m

10
0B

as
e-

T4
 9

0m

10
0B

as
e-

Tx
 1

00
m

10
0B

as
e-

T4
 7

0m

10
0B

as
e-

T4
 9

0m

10
0B

as
e-

T4
 1

00
m

10
0B

as
e-

Tx
 9

0m

10
0B

as
e-

Tx
 7

0m

10
0B

as
e-

Tx
 9

0m

10
0B

as
e-

Tx
 7

0m

10
0B

as
e-

Tx
 1

00
m

10
0B

as
e-

Tx
 6

0m

10
0B

as
e-

Tx
 8

0m

10
0B

as
e-

Tx
 1

00
m

10
0B

as
e-

Tx
 5

0m

10
0B

as
e-

Tx
 8

0m

10
0B

as
e-

Tx
 9

0m10
0B

as
e-

T4
 4

0m

10
0B

as
e-

T4
 6

0m

10
0B

as
e-

T4
 1

00
m



ЗАВДАННЯ 2. МОДЕЛЮВАННЯ ТЕЛЕКОМУНІКАЦІЙНИХ МЕРЕЖ 

В ПАКЕТІ NetCraker Pro 

Комп'ютерна система NetCracker Pro (фірма Division of Advanced Visual 

Data, Inc.) є інструментом  для моделювання й аналізу ефективності мережі, 

дозволяє перевіряти зв’язність мережі, можливість і ефективність 

використання в кожному конкретному випадку мережних пристроїв (як 

стандартних, так і замовлених), включає велику бібліотеку готових мережних 

пристроїв і можливість визначати нові типи пристроїв. 

Головне вікно NetCracker (крім заголовка, головного меню й панелей 

інструментів) складається із трьох фреймів: браузера (Browser) ліворуч, 

робочої зони (Workspace) праворуч і панелі зображень (Image) знизу. У 

головному вікні NetCracker розташовується шість блоків (Toolbars) меню, 

оформлених у вигляді кнопок, які дублюють варіанти головного меню. 

Панель рисовання (звичайно розташовується вертикально праворуч від 

робочої зони) активізується натисканням кнопки   або вибором View→ 

Bars → Drawing у головному меню (рис. 2.1). 

Для ознайомлення з роботою програми NetCracker зручно 

користуватися наявним проектом TUTOR.NET (розташований у каталозі 

./NetCracker /Samples). Проект відкривається (рис. 2.2) послідовним вибором 

варіантів головного меню File →Open або щигликом по відповідній кнопці в 

блоці кнопок, що розташовані у верхній частині головного вікна. У вікні 

робочої зони (зміна масштабу здійснюється View→Zoom) з'являється схема 

мережі, причому у вікні Top розташовується укрупнена схема проекту 

(щовключає два будинки Building і Building(2) і схематизоване у вигляді 

хмари зображення каналу зв'язку технології АТМ – Asynchronous Transfer 

Mode), у вікні Building – конкретизація схеми в будинку Building (вказівкою 

ієрархічної схеми служить обведення червоною смужкою об'єкта Building у 
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вікні Top і символ  у вікні Building). Подібний проект називається 

багаторівневим. 

 

 
Рисунок 2.1-Головне вікно програми NetCracker Pro 

 

Перейменування вікна сайту досягається вибором Sites > Sites Setup, 

перейменування об'єкта в робочій зоні (наприклад, будинку Building) 

реалізується вибором варіанта Properties з меню, що випадає при щиглику 

правої кнопки миші на обраному об'єкті. Рисувати, вводити текст або 

зображення в робочу зону можна, використовуючи меню Draw (активізується 

натисканням кнопки  або вибором View>Bars>Drawing у головному 

меню), повернення з режиму Draw здійснюється щигликом по кнопці  
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(перехід у стандартний режим). Запуск анімації досягається вибором 

Control>Start або F5, зупинка - Control>Stop або Alt+F5, пауза - 

Control>Pause або Space; кнопки  відповідно. Кнопки  

дозволяють збільшити, зменшити або встановити за замовчуванням 

швидкість анімації, кнопка  - вручну настроїти швидкість анімації, 

інтенсивність руху пакетів Packet speed і розмір пакетів Packet size (дії також 

доступні за допомогою варіанта Control головного меню). 

 

 
Рисунок 2.2-Робоча зона програми NetCracker Pro з проектом TUTOR.NET 

 

Пристрої для додавання в робочу зону вибираються з ієрархічної 

бази даних, яка розміщена у вікні браузера, причому можливо сортування по 

типах, виробниках або визначених користувачами пристроям (варіанти Types, 
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Vendors і User у списку який випадає з блоку меню 

; перші 4 кнопки служать для вибору 

режиму показу зображень пристроїв у панелі зображень - Великі/Дрібні 

значки/Список/Таблиця). При виборі закладки Recently User 

(Використовувані) у лівій нижній частині панелі зображень на останній 

показуються всі пристрої, що використовуються в даному проекті. 

Наприклад, для додавання в робочу зону конкретного 

маршрутизатора фірми Cisco Systems треба  у браузері вибрати групу 

‘Routers and bridges’ (Маршрутизатори й мости), щигликом миші за знаком 

‘плюс’ розкрити її й у підгрупі ‘Backbone’ (Магістральні) вибрати ‘Cisco 

Systems’ і далі підгрупу ‘Cisco 7010’; у панелі з'явиться сам маршрутизатор 

Cisco 7010 і модулі розширення для нього. 

Для вибору мережних адаптерів фірми 3Com для мережі Ethernet 

варто відкрити групу ‘LAN adapters’, підгрупу ‘Ethernet’ і далі підгрупу 

‘3COMCorp.'; у панелі зображень пристроїв з'являться зображення мережних 

адаптерів. 

Для додавання обраного пристрою в робочу зону досить перетягнути 

(за допомогою миші) його зображення з панелі зображень у робочу зону. 

Для одержання інформації по наявному в робочій зоні конкретному 

пристрою варто вибрати варіант Configuration з меню, яке випадає при 

щиглику правої клавіші миші коли курсор знаходиться в області зображення 

пристрою. Для маршрутизатора Cisco 7000, наприклад, відкриється діалог 

конфігурації Cisco 7000 (рис. 2.3). Діалоги конфігурації містять зображення 

пристрою, панель вибору конфігурації (праворуч), кнопки Device Setup 

(Настроювання пристрою), Plug-in Setup (Настроювання додаткового 

модуля), Close (Закрити) і Help (Допомога). Діалогове вікно рис. 3.3 

дозволяти в графічному режимі додавати (шляхом ‘перетягування’ мишею) 

модулі в ‘кошик’ пристрою. Наприклад, на рис. 2.3 в ‘кошик’ пристрою 

Cisco 7000 додані 4 модулі HSSI Interface Processor (процесор 

високошвидкісного послідовного інтерфейсу). У процесі перетаскування 
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курсор має форму  в тих місцях, куди не можна ‘покласти’ модуль, і 

форму  в тих місцях, куди модуль помістити можна. При щиглику мишею 

по будь-якому модулю, що перебуває в списку, стає доступною кнопка Plug-

in Setup, що говорить про можливості настроювання цього модуля. 

Діалогове вікно настроювання модуля приведене на рис. 2.4 

(викликається натисканням кнопки Plug-in Setup у вікні конфігурування, 

рис. 2.3) або за допомогою пункту Properties локального меню, що 

викликається правою кнопкою миші для модуля зі списку в правій частині 

рис. 2.3. 

 

 
Рисунок 2.3 —Діалогове вікно конфігурування пристрою Cisco 7000 

 

Кнопка Device Factory (доступ з головного меню за допомогою 

Database→Device Factory або Ctrl+Shift+F) дозволяє самостійно створити 
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нові  мережні пристрої із заданими параметрами (при цьому можливо їх 

створення на основі існуючих, але зі зміненими параметрами). 

У базі даних існує набір готових (вже сконфігурованих) 

узагальнених пристроїв (generic devices). Наприклад, у дереві пристроїв 

розташована група Switches, у ній – підгрупа Workgroup, у ній – Ethernet, у 

ній – Generic Devices. Обраний таким способом узагальнений пристрій 

зображується як  

 

 
Рисунок 2.4 — Діалогове вікно настройки модуля 
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Встановлення зв'язку між пристроями досягається щигликом по 

кнопці Link Devices  (варіант Sites→Modes→Link) з наступним щигликом 

мишею послідовно по двох пристроях, що підлягають зв'язуванню; у 

результаті відкривається діалогове вікно Link Assistant (рис. 2.5): 

Праворуч і ліворуч у вікні Link Assistant показані пристрої, зв'язок 

між якими повинен бути встановлений (кнопка Link, кнопка Unlink розриває 

зв'язок); причому у випадку наявності в пристрою декількох портів (як 

показано на рисунку 2.5 праворуч для комутатора Fast Ethernet) є можливість 

вибрати вільний. Кнопка Device Properties дозволяє уточнити параметри 

вузлів, група Link Setting – параметри лінії зв'язку (протокол, тип лінії зв'язку 

і її довжину, швидкість передачі даних). Кольори ліній зв'язку вказують на 

тип зв'язку (коаксіал, кручена пара, оптоволокно й т.і.) і може бути змінений 

за допомогою діалогу View→ Media Colors. 
 

 
Рисунок 2.5 — Діалогове вікно встановлення зв’язку між пристроями 
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Можливий варіант швидкої установки зв'язку – при натиснутій 

клавіші Shift на клавіатурі клацнути мишею послідовно по двох пристроях і 

відпустити Shift. Виклик вікна Link Assistant можливий і після встановлення 

зв'язку (наприклад, для зміни параметрів зв’язку) через меню Link Assistant, 

що випадає при натисканні правої кнопки миші (курсор при цьому повинен 

указувати на зв'язок, що цікавить).  

Розірвати/поновити зв'язок (наприклад, з метою аналізу впливу даної 

комунікаційної гілки на загальну картину функціонування мережі) можна 

кнопкою Break/Restore  (Sites→Modes→Break/Restore або Ctrl+8), при 

цьому розрив зв'язку показується символом . 

Для призначення потоків даних між мережними пристроями 

активізується кнопка Set Traffic  (те ж саме через головне меню 

Sites→Modes→Set Traffiс або Ctrl+5) з послідовними щигликами по зв'язаних 

пристроях, призначення потоків відбувається у вікні Profiles (рис. 2.6). 

 

 
Рисунок 2.6- Вікно Profiles для призначення потоків даних 
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Для призначення потоку даних у зворотному напрямку варто 

клацнути по пристроях у зворотному порядку. Робота з вікном Profiles 

завершується натисканням кнопки Assign. 

Якщо навести курсор на один зі стандартних профілів трафіков, 

наприклад, "Small office", потім клацнути правою кнопкою миші то в 

контекстному меню можна вибрати даний профіль трафіка (пункт Select). 

При виборі профілю можна змінювати характеристики профілю (кнопка 

Edit), задаючи статистику розмірів дейтаграм "Transaction size", статистику 

моментів приходу дейтаграм, пауз "Time between transactions", а також 

протокол рівня додатка "Application Layer Protocol". 

Подивіться на визначені Вами потоки даних у мережі можна у меню 

Global>Data Flow. Тут же можна відредагувати (у тому числі й видалити) 

властивості потоку й профілів трафіков. 

При призначенні потоків даних між вузлами необхідно враховувати 

наступне. При виборі трафіка клієнт-сервер, наприклад, профілю трафіка 

поштового клієнта "E-mail (POP)", необхідно встановити серверний додаток 

(у даному прикладі – поштовий сервер). Для цього, у браузері обладнання 

(закладка Devices) знайдіть групу "Network and Enterprise software". Потім 

перенесіть іконку "E-mail server" на комп'ютер-сервер. Після такої установки 

програмного забезпечення буде можливо призначати клієнт-серверні 

трафіки. Додати інші види серверного трафіка можна у властивостях 

програмного забезпечення сервера: Контекстне меню комп'ютера 

Configuration>Контекстне меню серверного програмного забезпечення 

Properties>Закладка Traffic.  

Для визначення виду статистичної інформації про потоки даних треба 

курсором миші вибрати зв'язок і з меню, що випадає по натисканню правої 

кнопки миші вибрати варіант Statistics. Вибір виду покажчика статистики 

здійснюється постановкою ‘галочок’ у потрібних стовпцях діалогового вікна  

Statistical Items (рис.2.7) (вид покажчика статистики указаний у верхній 

частині вікна - вертикальний покажчик, числове значення у відсотках і 
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графік), у лівій частині вікна знаходяться покажчики типу статистики 

(середнє й поточне навантаження мережі, поточне й усереднене 

використання, поточне число пакетів і т.і.).  
 

 
Рисунок 2.7. – Приклад вікна статистики Statistical Items 

Змінити параметри виведеного в робочій зоні тексту можна шляхом 

вибору варіанта Properties з меню, що випадає по щиглику правої кнопки 

миші коли  курсор находиться на тексті. 

Для перевірки й установлення протоколів маршрутизації служить 

закладка Protocols діалогового вікна Model Setting (викликається щигликом 

правої кнопки миші в будь-якому порожньому місці в межах робочої зони й 

вибором варіанта Model→Setting у меню що випадає, або при використанні 

головного меню Global Model Setting або Ctrl+G) , див. рис. 2.8. 

Як видно, у цьому випадку для протоколу TCP/IP обраний метод 

маршрутизації RIP (Routing Information Protocol), для вибору іншого варто 

клацнути по слову ‘RIP’ і зі списку, що випадає, вибрати бажаний (для 

TCP/IP доступні три варіанти RIP, OSPF і IGRP). 

Для одержання інформації про будь-який пакет варто навести на 

нього курсор миші (у режимі Pause при анімації) і вибрати з меню, що 
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випадає при щиглику правою кнопкою миші варіант Properties (вид вікна 

Packet Properties приведений на рис.2.9). 
 

 
Рисунок 2.8-Закладка Protocols діалогового вікна Model Setting 

 
Рисунок 2.9- Діалогове вікно Model Setting 
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У діалоговому вікні (рис.2.9) приведена інформація про додаток, 

який створив пакет, розмір пакета, його джерело й місце призначення, 

мережний й канальний протоколи. 

Для одержання твердої копії в NetCracker існують засоби генерації 

звітів (варіанти головного меню Tools→Reports). Наприклад, варіант звіту в 

Routers/Bridges (Маршрутизатори й Мости) дозволяє в табличній формі 

роздрукувати інформацію про маршрутизатори і мости, які 

використовуються в проекті. Варіант Bill Of Materials (Кошторис) містить 

повний список обладнання й цін на нього (включаючи сумарні витрати на 

обладнання). Отримати копію робочої зони (у будь-якому графічному 

форматі) можна використовуючи головне меню Tools→Graphic Export. 

 

ПОРЯДОК ВИКОНАННЯ ЗАВДАННЯ 2 

1. Запустити NetCracker. Відкрити в папці Samples проект згідно з варіантом. 

2. За допомогою браузера Device вивчити обладнання, яке може бути 

використане у проектуванні: 

2.1. Змінити режими браузера бази даних шляхом використання 

інструментальної панелі Database; для цього в полі зі списком вибирати 

або Vendors (сортування за абеткою по імені постачальника) або Types 

(сортування за абеткою по типу пристроїв). 

2.2. За допомогою вкладки Recently Used в області вікна зображення 

передивитися та скласти список пристроїв, які використовуються в 

проекті.  

3. Визначення типів зв'язків пристроїв проекту: щоб знати, які види зв'язків 

використовуються для підключення пристроїв, у меню View вибрати 

команду Legends. 

4. Отримання інформації про всю мережу, використовуючи повідомлення 

проекту: 

4.1. Для перегляду повідомлення в меню Tools виберати підменю Reports 
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4.2. Експортувати копію повідомлення за допомогою кнопки Export 

report. 

5. Запустіти анімацію проектів на інструментальній панелі Control. 

Скорегувати параметри анімації, натиснувши на кнопку Animation Setup. 

6. Визначення характеристик пакетів. Призупинити анімацію. Встановіть 

курсор на пакеті, викличте локальне меню і вибрати команду Properties. 

З'явиться діалогове вікно властивостей пакета (Packet Properties).  

7. Створення вигинів у зв'язках пристроїв і об'єктів  Призупинить анімацію 

та утримуючи кнопку CTRL клавіатури, двічі клацніть кнопкою миші 

безпосередньо на зв'язку. На зв'язку з'являється маркер захоплення (чорний 

квадрат). Натискаючи й утримуючи кнопку миші на захопленні, перетягніть 

її до нового місця розташування, потім відпустіть ліву кнопку миші. Зв'язок 

згинається в крапці(ах), яку Ви вибрали. 

8. Перегляд статистики зв`язку: 

8.1. Клацніть правою кнопкою на зв'язку 

8.2. У локальному меню виберіть Statistics. З'явиться діалогове вікно 

статистичних елементів. У діалоговому вікні статистичних об'єктів 

(Statistical Items) позначте блок використання (Utilization).  

8.3. Установіть індикатор Utilization для простого перегляду 

9. Порушення і відновлення зв'язків, вихід з ладу і ремонт пристроїв: 

9.1. Натисніть інструмент  (Break/Restore) на інструментальній панелі 

Modes. 

9.2. Порушити зв'язок між пристроями. Червоний спалах  указує на 

розрив, і трафік переорієнтується відповідно до поточного протоколу 

маршрутизації. 

9.3. Зверніться до локального меню. Виберіть у Model Settings позицію 

табуляції Protocols. Змініть протоколи та зробити висновки щодо їх 

доцільності. 

10. Створіть свій проект мережі по вихідним даним, які приведені в табл. 3.2.  
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11. Виконайте моделювання роботи мережі та зберіть статистику: середнє 

завантаження вузлів та каналів передачі даних; середня затримка; кількість 

прийнятих та відкинутих пакетів. 

 

Таблиця 2.1 – Варіанти завдань 

1 2 3 4 5 6 7 8 9 10 11 

12 13 14 15 16 17 18 19 20 21 22 

 

23 24 25 26 27 28 29 30 31 32 33 

Cajun *           

Circuit_Switching  *          

Client_server   *         

Frame_Relay    *        

Hier     *       

PacketStar      *      

Portmaster       *     

Router        *    

SNA         *   

Techno          *  

Tutor           * 
 

Таблиця 2.2 – Варіанти вихідних даних для створення проекту  мережі 

№ 

варіанту 

Кількість 

робочих 

станцій 

Кількість 

серверів 

Кількість 

концен-

траторів 

Тип 

середовища 

передачі 

Тип трафіка 

1 2 3 4 5 6 

1 10 2 2 1,3 1,5,10 

2 9 3 3 2,3 2,4,6,9 

3 8 3 2 3 2,3,7,10 

4 9 3 2 4 3,6,9,10 

5 10 2 2 1,3 1,5,7,10 
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Продовження таблиці 2.2 

1 2 3 4 5 6 

6 11 2 3 2,3 3,4,6,9 

7 10 2 2 4 1,8,2,7 

8 8 3 3 1,3 5,8,7,9,10 

9 10 3 3 4 1,2,7,10 

10 11 3 2 1,3 5,6,7,9 

11 12 2 3 2,3 2,3,4,7 

12 9 2 3 4 1,5,9,10 

13 10 3 2 1,3 2,5,7,10 

14 11 3 2 4 1,2,6,9 

15 12 2 2 1,3 1,3,6,10 

16 10 3 3 4 2,5,6,10 

17 12 2 3 2,3 3,8,9,10 

18 9 3 3 4 2,6,8,9 

19 8 2 2 1,3 1,6,7,8 

20 10 3 2 4 1,6,7,10 

21 12 2 3 2,3 5,8,9,10 

22 11 2 3 4 3,6,8,7 

23 10 3 3 1,3 4,7,9,10 

24 9 2 2 4 4,6,8,10 

25 10 3 2 2,3 5,6,7,9 

26 10 2 3 4 4,8,9,10 

27 11 2 3 1,3 1,2,4,7 

28 10 3 3 4 2,5,6,9 

29 9 2 2 2,3 3,4,9,10 

30 10 3 2 1,3 1,2,7,10 

Умовні позначення трафіка: 

1- Small office;  2 – E-mail (POP); 3 – LAN peer-to-peer traffic;  
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4 - Small interLAN traffic; 5 - InterLAN traffic; 6 – FTP; 7 – HTTP;  

8 - Small office peer-to-peer; 9 - File server's client; 10 - SQL server's client 

Умовні позначення середовища передачі: 

1 – “товстий” коаксіал (10Base-5);    2 – “тонкий” коаксіал (10Base-2) 

3 – кручена пара (10Base-Т);     4 – оптоволокно  (10Base-F) 

ЗМІСТ ЗВІТУ 

1. Проект мережі з усіма характеристиками пристроїв згідно з варіантом 

завдання (табл.2.2) 

2. Характеристики трафіків, що використовувались при проведенні 

імітаційного моделювання 

3. Статистичні показники роботи мережі. 

4. Висновки з аналізом отриманих результатів по кожному пункту 

виконання  завдання. 
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